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Аннотация
Книга является практическим и справочным руководством

и предназначена для самостоятельного изучения и подготовки
к работе в новой версии самой популярной и мощной
универсальной среды проектирования AutoCAD 2008,
разработанной компанией Autodesk. В издании приведены общие
сведения о системе, подробно рассмотрен пользовательский
интерфейс, описываются средства создания, редактирования и
оформления чертежей, принципы трехмерного моделирования,
включая получение реалистических изображений, а также
твердых копий чертежа. Книга рекомендована студентам
технических и дизайнерских специальностей. Работа выполнена
по приоритетному национальному проекту «Образование»
в  рамках инновационной образовательной программы
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Татьяна Юрьевна Соколова
AutoCAD 2008 для студента.
Популярный самоучитель

 
Введение

 
В настоящее время существует множество графических

редакторов и программ геометрического моделирования.
Компания Autodesk – один из ведущих производителей си-
стем автоматизированного проектирования и программного
обеспечения для конструкторов, дизайнеров, архитекторов.
Это крупнейший в мире поставщик программного обеспече-
ния и услуг для промышленного и гражданского строитель-
ства, машиностроения, геоинформатики, цифровых средств
передачи информации и беспроводной связи, обслуживаю-
щий 7 000 000 пользователей.

Система AutoCAD, разработанная этой компанией, яв-
ляется лидирующей в мире платформой программного
обеспечения систем автоматизированного проектирования
(САПР), предназначенной для профессионалов, которым
требуется воплощать свои творческие замыслы в реальные
динамические проекты.

AutoCAD – программа с богатой и во многом уникальной



 
 
 

историей. Впервые она увидела свет в 1982 году под име-
нем MicroCAD. Первая версия AutoCAD ознаменовала на-
чало настоящей революции в автоматизированном проекти-
ровании. Сегодня AutoCAD переводится на 18 языков, ее
используют в своей работе миллионы проектировщиков во
всем мире на процессорах в тысячи раз мощнее тех, которые
были установлены на первых персональных компьютерах.

AutoCAD является постоянно развивающейся базовой
средой проектирования, каждая новая версия которой на-
следует все лучшее от предыдущих и направлена на решение
следующих основных задач:

• повышение производительности и эффективности рабо-
ты пользователей;

• обеспечение многократного использования имеющихся
наработок;

•  беспрепятственное сотрудничество пользователей при
проектировании;

• адаптация AutoCAD к индивидуальным потребностям
разработчиков объектно-ориентированных задач.

Залог успеха Autodesk – мировое признание AutoCAD
в качестве стандарта де-факто для разработки продуктов и
комплектующих, а также для документации.

Используя свою стратегию, направленную на помощь за-
казчикам в создании, организации и распространении циф-
ровых конструкторских данных и в решении серьезных биз-
нес-проблем, Autodesk предлагает наиболее полный ком-



 
 
 

плект интегрированных программных инструментов дву-
мерного и трехмерного конструирования, что позволяет со-
здавать более качественные продукты, ускорять вывод изде-
лий на рынок и добиваться максимальной наглядности про-
ектов и максимально эффективного сотрудничества.

Благодаря выпуску AutoCAD 2008 компания Autodesk
предлагает архитекторам, инженерам и проектировщикам
новый инструмент для еще более полного воплощения их
идей в реальность.



 
 
 

 
От издательства

 
Ваши замечания, предложения и вопросы отправ-

ляйте по следующему адресу электронной почты:
dgurski@minsk.piter.com (издательство «Питер», компью-
терная редакция).

Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете по-

дробную информацию о наших книгах.

mailto:%20dgurski@minsk.piter.com
http://www.piter.com/


 
 
 

 
Глава 1

AutoCAD 2008. Общие сведения
 
 

Требования к системе
 

AutoCAD 2008 может работать как в автономном ре-
жиме, так и в локальной сети. Для эффективной рабо-
ты AutoCAD 2008 под управлением операционной системы
Windows необходимы следующие программные и аппарат-
ные средства:

• процессор Intel® Pentium® IV;
•  операционные системы: Microsoft® Windows® ХР

Professional или Home Edition (пакет обновлений SP1 или
SP2), Windows ХР Tablet PC Edition (SP2) или Windows 2000
(SP3 или SP4). Рекомендуется устанавливать и эксплуатиро-
вать AutoCAD либо на операционной системе, локализован-
ной на одном языке с программой, либо на англоязычной
версии одной из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1
или более поздний);

• 512 Мбайт оперативной памяти;
• монитор VGA с разрешением не менее 1024 х 768 и под-

держкой режима true color;



 
 
 

• 750 Мбайт свободного места на жестком диске для уста-
новки;

•  привод компакт-дисков: любой (только для установки
программы).

Требования к системе при использовании AutoCAD 2008
для концептуального проектирования:

• процессор Intel® с тактовой частотой 3,0 ГГц и выше;
• Windows ХР Professional (пакет обновлений SP2);
• не менее 2 Гбайт оперативной памяти;
• 2 Гбайт свободного места на жестком диске, не считая

места, необходимого для установки программы;
• Монитор с минимальным разрешением 1280 х 1024 и

поддержкой режима true color;
• графический адаптер класса рабочих станций, снабжен-

ный не менее 128 Мбайт памяти и поддерживающий техно-
логию OpenGL.



 
 
 

 
Установка AutoCAD

 
Чтобы успешно установить AutoCAD, понадобится вы-

полнить несколько подготовительных шагов.
Для подготовки к установке следует:
•  выяснить серийный номер – он должен быть напеча-

тан на упаковке AutoCAD 2008. В случае обновления од-
ной из прежних версий AutoCAD требуется использовать се-
рийный номер предыдущей версии. Его можно либо найти
на соответствующей упаковке, либо узнать, выбрав в меню
AutoCAD пункты Help → About;

•  воспользоваться правами администратора локального
компьютера, на который будет установлен AutoCAD. Иметь
права администратора домена при этом необязательно;

• закрыть все работающие приложения;
• отключить средства антивирусной защиты.
Установка AutoCAD выполняется с помощью специаль-

ной программы-инсталлятора, которая переписывает фай-
лы с компакт-дисков в папку, созданную на жестком диске
компьютера. В ходе установки AutoCAD автоматически на-
страивается на работу с системным устройством указания и
WHIP-драйвером монитора.



 
 
 

 
Запуск системы AutoCAD

 
Запуск AutoCAD осуществляется следующими способа-

ми:
• на Панели задач выберите из меню Start → Programs →

Autodesk → AutoCAD 2008;
• на Рабочем столе Windows дважды щелкните на пикто-

грамме AutoCAD 2008.
При запуске AutoCAD создается новый неименованный

рисунок. Можно либо начать создавать в нем объекты, либо
загрузить с диска один из уже имеющихся файлов.

При открытии ранее подготовленного имеющегося рисун-
ка всем системным переменным присваиваются значения,
которые они имели в ходе последнего сеанса работы с ним.
Это происходит благодаря тому, что переменные сохраняют-
ся в файле вместе с рисунком.

Если же вы начинаете работу «с нуля», следует предвари-
тельно задать ряд установок. Обычно это делается автома-
тически с помощью Мастера подготовки Wizard Description.
AutoCAD позволяет менять установки и в ходе сеанса, если
возникает такая необходимость.



 
 
 

 
Начало работы

 
После запуска AutoCAD выводится диалоговое окно на-

чала работы Startup (рис. 1.1).
В диалоговом окне Startup пользователю предлагается че-

тыре кнопки, в зависимости от выбора которых меняется со-
держимое диалогового окна.

Open a Drawing – для открытия ранее созданного чертежа.
Позволяет выбрать из списка один из рисунков, открывав-
шихся последними, и загрузить его в AutoCAD. Чтобы за-
грузить файл, отсутствующий в списке, следует нажать кноп-
ку обзора Browse….

Start from Scratch – для создания чертежа, где устанавли-
ваются только единицы измерения в области Default Settings:
британские (футы и дюймы) или метрические (миллимет-



 
 
 

ры):
• Imperial (feet and inches) – создание нового рисунка, ко-

торый использует британскую систему единиц измерения по
шаблону acad.dwt. При этом область рисования, называемая
еще лимитами рисунка, устанавливается равной 12x9 дюй-
мов;

• Metric – создание нового рисунка, использующего мет-
рическую систему единиц измерения по шаблону acadiso.
dwt. При этом область рисования устанавливается равной
429 х 297 мм.



 
 
 

Рис. 1.1. Диалоговое окно начала работы

Use a Template – для создания чертежа по шаблону – доку-
менту, установки которого используются как основа для но-
вого рисунка. В области Select a Template: выбирается шаб-
лон, содержащий необходимые установки черчения. В спис-
ке перечисляются имена файлов шаблонов с расширением
DWT, которые найдены по стандартному пути, заданному в
диалоговом окне настроек Options. В шаблонах определяют-
ся различные параметры рисунка, в том числе наборы спе-
циально созданных слоев, типов линий и видов.

Use a Wizard – вызов Мастера для установки параметров
нового чертежа. В области Select a Wizard: предлагается два
режима автоматической настройки рабочей среды AutoCAD
– детальная подготовка Advanced Setup и быстрая подготов-
ка Quick Setup:

• диалоговое окно детальной подготовки Advanced Setup



 
 
 

позволяет выполнить полную установку параметров рабочей
среды AutoCAD: назначить единицы измерения длины Units
и угла Angle, задать начало отсчета угла Angle Measure и на-
правление его измерения Angle Direction, определить грани-
цы области рисунка Area;

• диалоговое окно быстрой подготовки Quick Setup поз-
воляет выполнить быструю установку параметров рабочей
среды AutoCAD: выбрать единицы измерения длины Units и
определить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при
каждой загрузке сеанса AutoCAD только один раз. В даль-
нейшем для создания рисунков в уже запущенном сеансе
AutoCAD открывается диалоговое окно создания нового ри-
сунка Create New Drawing.



 
 
 

 
Подробнее о шаблоне

 
Установленный набор параметров сеанса можно сделать

доступным и для рисунков, создаваемых впоследствии. Для
этого следует сохранить документ как шаблон. Шаблон
обычно представляет собой рисунок, не содержащий ника-
ких графических объектов и используемый только для хра-
нения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удоб-
ное средство создания набора рисунков с однотипными на-
стройками. Можно использовать как шаблоны, поставляе-
мые с AutoCAD, так и созданные пользователем. Любой
имеющийся рисунок можно сохранить в качестве шаблона.
В этом случае значения всех параметров настройки сохра-
няемого документа будут наследоваться всеми создаваемы-
ми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше
всего подготовить набор стандартных шаблонов, где пред-
ставлены чаще всего используемые установки и базовые эле-
менты:

• тип и точность представления единиц;
• лимиты рисунка;
• настройки режимов шага SNAP, сетки GRID и ортого-

нального режима ORTHO;
• организация слоев;



 
 
 

• основные надписи, рамки и логотипы;
• размерные и текстовые стили;
• типы и веса (толщины) линий.
Никакие изменения, вносимые в рисунок, созданный на

основе шаблона, на сам шаблон не распространяются.



 
 
 

 
Вызов справочной системы

 

В любой момент работы с AutoCAD вы можете получить
доступ к электронной документации по программе. Для это-
го необходимо выбрать в падающем меню пункт Help. Аль-
тернативный вариант – нажать клавишу F1 на функциональ-
ной клавиатуре, ввести символ? в  командной строке или
щелкнуть на пиктограмме со значком вопроса на стандарт-
ной панели инструментов.



 
 
 

 
Открытие рисунков

 
Программа AutoCAD по умолчанию записывает внутрен-

нее представление рисунка в файл с расширением DWG.
Кроме рисунка файл содержит ряд параметров, определяю-
щих значения переключателей режимов шага SNAP, сетки
GRID, ортогонального режима ORTHO; принятые единицы
измерения и точность представления; границы рисунка; ор-
ганизацию слоев; форматы и логотипы; размерные и тексто-
вые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирова-
ния Multiple Design Environment (MDE), которая допускает
одновременное открытие нескольких чертежей. В одном се-
ансе работы можно открывать неограниченное количество
рисунков, не жертвуя при этом производительностью. Среда
MDE позволяет перетаскивать объекты, копировать их свой-
ства, такие как цвет, слой, тип линии, из одного рисунка в
другой. Она обеспечивает параллельную работу с нескольки-
ми рисунками, не прерывая выполнения текущей команды и
не нарушая последовательности действий. Это существенно
упрощает выполнение многих операций и повышает эффек-
тивность работы.



 
 
 

Открыть существующий рисунок можно с помощью ко-
манды OPEN, которая вызывается из падающего меню File
→ Open… или щелчком на пиктограмме Open…CTRL+О на
стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD
появляется диалоговое окно выбора файла Select File
(рис. 1.2). Здесь можно выбрать имя файла из списка или
ввести это название в поле File name:.

При выделении в списке одного из файлов в области
Preview появляется соответствующий образец рисунка. На-
жатие кнопки Views выводит список, изменяя параметры ко-
торого пользователь может выбрать форму представления
файлов, предлагаемых для открытия: список, таблицу, об-
разцы.



 
 
 

Рис. 1.2. Диалоговое окно выбора файла

Режим открытия файлов – Open (открыть), Open Read-
Only (открыть для чтения), Partial Open (открыть частич-
но), Partial Open Read-Only (открыть для чтения частич-
но) – устанавливается в списке при нажатии стрелки спра-
ва от кнопки Open. Частичное открытие позволяет загру-
жать только те объекты рисунка, которые принадлежат опре-
деленным слоям или видовым экранам. Это оказывается по-
лезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следу-
ет выбрать необходимые файлы в диалоговом окне Select



 
 
 

File, используя клавишу Shift или Ctrl.
Кроме того, рисунки можно открывать путем перетаски-

вания из Проводника Windows. Для этого один или несколь-
ко выделенных в дереве Проводника файлов следует перета-
щить с помощью мыши в любую часть окна AutoCAD, за ис-
ключением области рисунка, например на командную стро-
ку или в ту часть панелей инструментов, которая не занята
кнопками. Если же перетащить один файл в область рисова-
ния уже открытого рисунка, то произойдет вставка содержи-
мого перетаскиваемого документа в текущий рисунок в ка-
честве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени
соответствующего файла в Проводнике Windows, что приве-
дет к автоматическому запуску AutoCAD. Если же в системе
уже ведется сеанс работы в AutoCAD, то рисунок откроется
в нем.

В AutoCAD имеется специальное средство просмотра
небольших фрагментов рисунков, открытия файлов рисун-
ков и их поиска. Его можно использовать для поиска файлов
в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска фай-
лов Find, показанного на рис. 1.3, необходимо в диалоговом
окне Select File последовательно щелкнуть на кнопках Tools
→ Find….



 
 
 

Рис. 1.3. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find ука-
зываются имя, расширение и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам
их создания, пользуясь вкладкой Date Modified диалогового
окна Find (рис. 1.4). Здесь организуется поиск файлов, со-
зданных или измененных в период между двумя указанны-
ми датами либо за определенное количество последних дней
или месяцев. Имена найденных документов отображаются в



 
 
 

нижней части диалогового окна.

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей
версии, открываются как любой документ версии 2008 и ав-
томатически преобразуются в новый формат.



 
 
 

 
Создание рисунков

 
При создании рисунка могут использоваться различные

стандарты. Иногда они диктуются государственными и от-
раслевыми стандартами или нормами предприятия, иногда
– требованиями заказчика. Ключевой момент как для непо-
средственных исполнителей, так и для руководителей групп,
контролирующих ход выполнения проекта, – грамотная под-
готовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект.
Он может включать в себя множество разделов: планы эта-
жей, схемы сетей водоснабжения, канализации, отопления,
вентиляции и т. п. Обычно каждый раздел проекта разраба-
тывается в отдельном подразделении, поэтому здесь остро
встает проблема унификации. Наиболее грамотное ее реше-
ние – обеспечение всех исполнителей файлами шаблонов,
настроенными на используемую систему единиц и содержа-
щими стандартные рамку, основную надпись, слои и типы
линий.

Не менее важно, какие стили используются для текстовых
надписей, штрихования и нанесения размеров. Их также сле-
дует задавать заранее: это дает гарантию, что каждый проек-
тировщик будет действовать без отклонения от оговоренных
стандартов.

Следует ответственно подходить к выбору рабочего мас-



 
 
 

штаба. Только четкое представление о том, как соотносятся
единицы рисунка на экране и единицы чертежа, выводимого
на плоттер, позволяет правильно выбрать высоту текста для
пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на по-
следних стадиях проектирования, грамотное планирование
на предварительных этапах позволяет избежать многих оши-
бок и избавить персонал от излишних операций редактиро-
вания. При создании проекта работа, как правило, ведется в
пространстве модели (здесь объекты представляются в нату-
ральную величину), а для компоновки чертежа выполняется
переход в пространство листа, где ко всем графическим объ-
ектам, текстам, типам линий и размерам применяется необ-
ходимый масштабный коэффициент.

Все начальные установки рисунка могут быть сохранены
в шаблоне для последующего использования в других доку-
ментах. В качестве шаблона могут применяться как рисунки,
поставляемые с AutoCAD, так и любые другие, в том чис-
ле созданные пользователем. Новый рисунок наследует всю
информацию из используемого шаблона. Имеется также воз-
можность запускать AutoCAD без шаблона.

Создать новый рисунок позволяет команда NEW, вызы-



 
 
 

ваемая из падающего меню File → New… или щелчком на
пиктограмме QNew на стандартной панели инструментов.

После запуска команды необходимые настройки парамет-
ров рабочей среды AutoCAD производятся в диалоговом ок-
не создания нового рисунка Create New Drawing – рис. 1.5.

Рис. 1.5. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону исполь-
зуется пиктограмма Start from Scratch. В данном режиме
устанавливается британская или метрическая система еди-
ниц. Важно, что значения многих системных переменных,



 
 
 

принятые по умолчанию, зависят от того, какая из двух си-
стем выбрана. Эти переменные управляют текстом, размера-
ми, сеткой, режимами привязки, а также устанавливают дей-
ствующие по умолчанию тип линий и файл образцов штри-
ховки:

• Imperial (feet and inches) – создается рисунок, который
использует британскую систему единиц измерения (футы и
дюймы), по шаблону acad. dwt. При этом область рисования,
иначе называемая лимитами рисунка, устанавливается рав-
ной 12x9 дюймов;

• Metric – создается рисунок, где используется метриче-
ская система единиц измерения, по шаблону acadiso.dwt.
При этом устанавливается область рисования 429 х 297 мм.

Чтобы создать рисунок с использованием шаблона, необ-
ходимо в диалоговом окне Create New Drawing щелкнуть на
пиктограмме Use a Template и в списке Select a Template:
указать нужный шаблон (рис. 1.6).



 
 
 

Рис. 1.6. Выбор шаблона рисунка

В AutoCAD имеется так называемый Мастер подготовки
Wizard – служебное средство для создания нового рисунка.
С помощью Мастера подготовки можно, взяв за основу теку-
щий шаблон, модифицировать некоторые базовые установ-
ки. Например, пользователь может автоматически настраи-
вать масштабные коэффициенты для текста в зависимости
от общих размеров рисунка. Если рисунки крупные, выбира-
ется большая высота символов, если мелкие – меньшая; та-
ким образом обеспечивается разборчивость текстовых над-
писей, когда рисунок отображается на экране целиком.



 
 
 

Для вызова Мастера подготовки необходимо в диалого-
вом окне Create New Drawing щелкнуть на пиктограмме Use
a Wizard – откроется окно, показанное на рис. 1.7.

Рис.  1.7. Создание нового рисунка с помощью Мастера
подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.8) позво-
ляет задать для нового рисунка единицы измерения Units
и область рисования Area. Поддерживаются следующие ти-
пы единиц для рисования и вычерчивания: десятичные
– Decimal, инженерные – Engineering, архитектурные –



 
 
 

Architectural, дробные – Fractional, научные – Scientific.

Рис. 1.8. Диалоговое окно Мастера быстрой подготовки

Указывая ширину Width и длину Length области рисова-
ния, пользователь тем самым задает граничные пределы ри-
сунка, так называемые лимиты. Именно лимитами опреде-
ляется размер чертежа, впоследствии выводимого на плот-
тер. После того как все параметры заданы, Мастер быстрой
подготовки запускает сеанс рисования в пространстве моде-
ли.

Мастер детальной подготовки Advanced Setup (рис. 1.9)
позволяет задать для нового рисунка тип линейных единиц
измерения Units и способ измерения углов Angle, указать на-



 
 
 

чало отсчета угла Angle Measure и направление измерения
угла Angle Direction, определить границы области рисунка
Area. В отличие от Мастера быстрой подготовки, который
настраивает только пространство модели, Мастер детальной
подготовки воздействует как на пространство модели, так и
на пространство листа.

Рис. 1.9. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования,
в дальнейшем может быть изменена.



 
 
 

 
Определение границ рисунка

 
Команда LIMITS позволяет установить границы текущего

рисунка в пространстве модели и в пространстве листа. Она
вызывается из падающего меню Format → Drawing Limits. В
AutoCAD границы рисунка выполняют две функции: опре-
деляют диапазон изменения координат точек и контролиру-
ют фрагмент рисунка, покрытый видимой координатной сет-
кой.

Границы рисунка – это пара двумерных точек в мировой
системе координат: координаты левого нижнего и правого
верхнего углов, определяющие прямоугольную область. По
оси Z границы не устанавливаются.

Запросы команды LIMITS:
Reset Model space limits:  – переустановка лимитов про-

странства модели
Specify lower left corner or [ON/OFF] <current>: – левый

нижний угол
Specify upper right corner <current>:  – правый верхний

угол
где:
•  ON – включается контроль соблюдения границ. При

этом AutoCAD отвергает все попытки ввести точки с коор-
динатами, выходящими за границы рисунка;

• OFF – отключается контроль соблюдения границ рисун-



 
 
 

ка;
• <current> – текущее значение.
Если текущее значение границ рисунка вас устраивает,

достаточно нажать клавишу Enter.
Лимиты должны полностью охватывать полномасштаб-

ную модель. Например, если ее размеры 100 х 200 мм, зна-
чения лимитов должны слегка превышать эти цифры.

В пространстве листа лимиты обычно задают равными
формату листа бумаги. Следовательно, сетка (если она вклю-
чена) покрывает при этом весь скомпонованный чертеж,
включая графические объекты, размерные элементы, основ-
ную надпись и т. п. Например, если формат листа равен 210
х 297 мм, следует установить десятичный формат единиц и
определить лимиты указанием точек 0, 0 для левого нижнего
угла прямоугольника и210,297– для правого верхнего угла.

Если в пространстве листа отображаются поля листа или
подложен заданный формат, нельзя задать границы рисун-
ка с помощью команды LIMITS. В этом случае лимиты вы-
числяются и устанавливаются в зависимости от размеров вы-
бранного листа. Включение и отключение отображения по-
лей и разметки листа производятся на вкладке Display диа-
логового окна Options.

В пространстве модели лимиты могут быть заданы при со-
здании нового рисунка с помощью Мастера быстрой подго-
товки или Мастера детальной подготовки.



 
 
 

 
Определение параметров сетки

 
Сеткой называется упорядоченная последовательность

точек, покрывающих область рисунка в пределах лимитов.
Работа в режиме GRID подобна наложению на рисунок ли-
ста бумаги в клетку. Использование сетки помогает вырав-
нивать объекты и оценивать расстояние между ними. Сетку
можно включать и отключать в ходе выполнения других ко-
манд. На печать она не выводится.

Включение сетки и определение ее частоты осуществля-
ется на вкладке Snap and Grid диалогового окна режимов ри-
сования Drafting Settings (рис. 1.10), которое загружается из
падающего меню Tools → Drafting Settings… или при выборе
пункта настройки Settings… контекстного меню, вызываемо-
го щелчком правой кнопки мыши на кнопке GRID в строке
состояния.



 
 
 

Рис. 1.10. Диалоговое окно определения параметров сет-
ки и шага привязки

Сетка включается при установке флажка Grid On (F7). В
области Grid spacing устанавливается частота горизонталь-
ных и вертикальных делений сетки, то есть шаг сетки по
осям X и Y. Это осуществляется в текстовых полях Grid X
spacing: и Grid Y spacing: соответственно. В поле Major line



 
 
 

every: устанавливается шаг основной линии.
В области Grid behavior определяется режим сетки:

Adaptive grid – настройка сетки, Allow subdivision below grid
spasing – разрешение дробления мельче шага сетки, Display
grid beyond Limits – показать сетку за лимитами, Follow
Dynamic UCS – следовать динамической ПСК.

При работе с рисунком включать и отключать сетку сле-
дует щелчком на кнопке GRID в строке состояния или на-
жатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с
новым коэффициентом экранного увеличения может потре-
боваться изменение частоты сетки.



 
 
 

 
Определение шага привязки

 
В режиме шаговой привязки SNAP курсор может нахо-

диться только в определенных точках согласно установлен-
ному значению шага и при этом движется не плавно, а скач-
кообразно между узлами воображаемой сетки, как бы «при-
липая» к ним. Активность режима шаговой привязки SNAP
можно определить визуально, по скачкообразному движе-
нию курсора на экране. Шаговая привязка обычно использу-
ется для точного указания точек с помощью мыши. Интер-
вал привязки задается отдельно по осям XnY. Включение и
отключение режима шаговой привязки может производить-
ся в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сет-
ки. Сетку часто делают достаточно редкой, используя ее ис-
ключительно для наглядности, а шаг привязки устанавлива-
ют меньшим. Допустимо и обратное: установка большего по
сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее пара-
метров осуществляются на вкладке Snap and Grid диалогово-
го окна режимов рисования Drafting Settings, которое загру-
жается из падающего меню Tools → Drafting Settings… или
при выборе пункта Settings… из контекстного меню, вызы-
ваемого щелчком правой кнопки мыши на кнопке SNAP в
строке состояния (см. рис. 1.10).



 
 
 

Шаговая привязка включается при установке флажка
Snap On (F9). В области Snap spacing задается шаг привязки
по горизонтали и вертикали. Это осуществляется в тексто-
вых полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается рав-
ный шаг по осям X и Y. В области Polar spacing устанавлива-
ется шаг полярной привязки.

Тип привязки устанавливается в области Snap type. Grid
snap – шаговая привязка (Rectangular snap – ортогональная,
Isometric snap – изометрическая), PolarSnap – полярная при-
вязка.

При работе с рисунком включать и отключать шаговую
привязку следует щелчком на кнопке SNAP в строке состо-
яния или нажатием функциональной клавиши F9.

Совет
Выполните упражнение L4 из раздела 2.



 
 
 



 
 
 

 
Сохранение рисунков

 

Команда сохранения рисунка QSAVE вызывается из па-
дающего меню FileSave или щелчком на пиктограмме Save
CTRL+S на стандартной панели инструментов. Команда
QSAVE используется в тех случаях, когда уже существую-
щий рисунок сохраняется без изменения его имени. Если ри-
сунок новый и его имя не определено, то QSAVE действует
так же, как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохране-
ния рисунка под другим именем. Команда SAVE может вы-
зываться только из командной строки, a SAVEAS – из падаю-
щего меню File → Save As…. В обоих случаях имя докумен-
та задается в поле File name: диалогового окна Save Drawing
As – рис. 1.11.



 
 
 

Рис. 1.11. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается рас-
ширение ВАК вместо DWG. Все предыдущие ВАК-файлы
с данным именем удаляются. Обновленный рисунок запи-
сывается с расширением DWG. Если при указании имени
файла оказывается, что рисунок с таким названием уже су-
ществует, выдается предупреждение и предоставляется воз-
можность перезаписать файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в
раскрывающемся списке Files of type: диалогового окна Save
Drawing As необходимо выбрать пункт AutoCAD Drawing



 
 
 

Template (*.dwt).
Чтобы обеспечить автоматическое сохранение рисунка

через заданные интервалы времени, следует использовать
системную переменную SAVETIME или вкладку Open and
Save диалогового окна Options. Оно вызывается из падающе-
го меню Tools → Options…. В последнем случае необходи-
мо поставить флажок автосохранения Automatic save в обла-
сти File Safety Precautions и установить значение интервала
в минутах между автосохранениями в поле Minutes between
saves.



 
 
 

 
Получение твердой копии рисунка

 
Распечатка чертежа – последний этап при работе с рисун-

ком. Перед выводом рисунка на печать необходимо его ском-
поновать, то есть определить, какие виды должны быть вы-
черчены. Работа над рисунком ведется на разных этапах ли-
бо в пространстве модели, либо в пространстве листа. Про-
странство модели предназначено для создания модели –
изображения в реальном масштабе. Пространство листа
представляет собой аналог листа бумаги, на котором произ-
водится создание и размещение видов перед вычерчивани-
ем.

Как в пространстве модели, так и в пространстве листа
может быть один или несколько видовых экранов, на кото-
рых представлены различные виды модели. Компоновка чер-
тежа, по сути дела, представляет собой процесс создания и
размещения таких экранов. По завершении компоновки чер-
теж выводится на принтер или плоттер.

Перед выводом рисунка на плоттер можно предваритель-
но просмотреть, как он будет размещаться на листе бума-
ги. Для этого используется команда предварительного про-



 
 
 

смотра PREVIEW, вызываемая из падающего меню File →
Plot Preview или щелчком на пиктограмме Plot Preview на
стандартной панели инструментов. При этом автоматиче-
ски включается изменение масштаба изображения в режи-
ме реального времени для просмотра мелких деталей черте-
жа. Для изменения режима масштаба изображения, вывода
на плоттер, использования панорамирования или выхода из
предварительного просмотра используется контекстное ме-
ню (рис. 1.12), которое вызывается в ответ на щелчок правой
кнопкой мыши.

Рис. 1.12. Контекстное меню

Все установки вывода рисунка на плоттер осуществляют-



 
 
 

ся в диалоговом окне Plot – Model (рис. 1.13). Это окно за-
гружается командой PLOT, вызываемой из падающего меню
File → Plot… или щелчком на пиктограмме Plot.. CTRL+P
на стандартной панели инструментов.

В диалоговом окне Plot – Model делаются следующие на-
значения.

• В области Page setup устанавливается набор параметров
листа. Кнопкой Add… открывается диалоговое окно добав-
ления набора параметров листа.

• В области Printer/plotter устанавливаются параметры:
– из списка Name: выбирается устройство вывода;
–  кнопка Properties… загружает редактор параметров

плоттера;
–  установкой флажка Plot to file назначается печать в

файл.
• В области Paper size определяется формат.
• В области Number of copies устанавливается количество

экземпляров.
• В области Plot area устанавливается печатаемая область:

Display – экран, Limits – лимиты, Window – рамка.
• В области Plot offset (origin set to printable area) опреде-

ляется смещение печатаемой области по X и Y, а также цен-
трированность.

• В области Plot scale определяется масштаб печати и веса
линий:

– Fit to paper – вписать;



 
 
 

– Scale: – масштаб;
– Scale lineweights – масштабировать веса линий.

Рис. 1.13. Диалоговое окно вывода на печать пространства
модели

• В области Plot style table (pen assignments) определяется
таблица стилей печати.

• В области видовых экранов с раскрашиванием Shaded
viewport options определяется:

– Shade plot – способ вывода (как на экране, каркас, скры-



 
 
 

тие линий; 3D-скрытый, 3D-каркас, концептуальный, реали-
стичный; тонирование, черновое, низкое, среднее, высокое,
презентационное);

–  Quality – качество (черновое, просмотр, нормальное,
презентационное, максимум, пользовательское).

• В области Plot options определяются параметры печати:
– Plot in background – печатать в фоновом режиме;
– Plot object lineweights – учитывать веса линий;
– Plot with plot styles – учитывать стили печати;
– Plot paperspace last – объекты листа последними;
– Hide paperspace objects – скрывать объекты листа;
– Plot stamp on – включить штемпель;
– Save changes to layout – сохранить параметры.
• В области Drawing orientation определяется ориентация

чертежа:
– Portrait – книжная;
– Landscape – альбомная;
– Plot upside-down – перевернутая.
•  Кнопка Preview… загружает окно предварительного

просмотра.



 
 
 

 
Выход из AutoCAD

 
Для выхода из AutoCAD используется команда QUIT, ко-

торая вызывается из падающего меню File → Exit CTRL+Q.
Команда позволяет сохранить или проигнорировать сде-

ланные в рисунке изменения и выйти из AutoCAD. Если
все выпоненные изменения сохранены, при выходе из про-
граммы не появится никаких дополнительных сообщений. В
противном случае на экран будет выведено диалоговое ок-
но AutoCAD (рис. 1.14), предлагающее пользователю выбор:
сохранить изменения, отказаться от них или продолжить се-
анс работы.

Рис. 1.14. Диалоговое окно сохранения изменений в ри-
сунке



 
 
 

Если текущему рисунку не было присвоено имя и вы хо-
тите его сохранить, откроется диалоговое окно Save Drawing
As.



 
 
 

 
Глава 2

Пользовательский
интерфейс AutoCAD

 
На рис. 2.1. показан классический рабочий стол AutoCAD

для Windows.

Рис. 2.1. Рабочий стол AutoCAD



 
 
 

В данный рабочий стол включены:
• падающие меню – верхняя строка, расположенная непо-

средственно под заголовком окна программы;
• необязательные панели инструментов:
–  стандартная панель Standard и панель стилей Styles –

вторая строка от заголовка;
– панель рабочих пространств Workspaces, слоев Layers и

свойств Properties – третья строка;
–  панель рисования Draw и редактирования Modify –

столбцы слева;
• строка состояния – строка внизу окна программы;
• окно командных строк – выше строки состояния;
• графическое поле, занимающее остальную часть рабоче-

го стола.



 
 
 

 
Падающие меню

 
Строка падающих меню может быть изменена путем до-

бавления либо удаления тех или иных пунктов. Для это-
го необходимо выбрать в падающем меню пункты Tools
→ Customize → Interface…, в появившемся диалоговом
окне настройки интерфейса пользователя Customize User
Interface на вкладке Customize, в области Customizatios in All
CUI Files раскрыть пункт Menus (рис. 2.2). Далее установить
указатель мыши на один из пунктов меню и, щелкнув пра-
вой кнопкой мыши, вызвать контекстное меню, в котором
выбрать соответствующий пункт для удаления имеющихся
или создания новых падающих меню.



 
 
 

Рис. 2.2. Диалоговое окно адаптации меню

Строка падающих меню по умолчанию содержит следую-
щие пункты:

• File – команды работы с файлами: создание, открытие,
сохранение, публикация в Интернете, печать, экспорт фай-



 
 
 

лов в другие форматы, а также диспетчеры параметров ли-
стов, плоттеров, стилей печати и пр.;

• Edit – инструменты для редактирования частей графи-
ческого поля рабочего стола программы, работы с буфером
обмена и пр.;

• View – управление экраном, зумирование, панорамиро-
вание, установка трехмерной точки зрения, создание видо-
вых экранов и именованных видов, установка визуальных
стилей, тонирование, анимация траектории перемещения,
установка необходимых панелей инструментов;

•  Insert – команды вставки блоков, внешних объектов,
объектов других приложений;

• Format – команды работы со слоями и их инструмента-
ми; цветом, типами линий; управление стилями текста, раз-
меров, мультилиний, таблиц; видом маркера точки; установ-
ки единиц измерения, границ чертежа;

•  Tools – управление рабочими пространствами; палит-
рами; установка порядка прорисовки объектов и получение
сведений о них; работа с блоками и их атрибутами; рабо-
та с языком AutoLISP; работа с пользовательской системой
координат; настройка стандартов оформления; управление
Мастерами (публикации в Интернете, установки плоттеров,
создания таблиц стилей печати, цветозависимых стилей пе-
чати, компоновки листа, создания подшивки, импорта пара-
метров печати); установка параметров черчения и привязок
с помощью диалоговых окон и пр.;



 
 
 

• Draw – команды двумерного и трехмерного рисования;
• Dimension – команды простановки размеров и управле-

ния параметрами размерных стилей;
• Modify – команды редактирования элементов чертежа;
• Window – многооконный режим работы с чертежами;
• Help – вывод на экран системы гипертекстовых подска-

зок.



 
 
 

 
Панели инструментов

 
Команды AutoCAD на панелях инструментов представле-

ны в виде пиктограмм. Если задержать указатель мыши на
пиктограмме, рядом с ней появляется название соответству-
ющей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен ма-
ленький черный треугольник, это значит, что она содержит
подменю с набором родственных команд. Для вызова подме-
ню необходимо на некоторое время задержать на пиктограм-
ме указатель мыши, нажав ее левую кнопку.

Панели инструментов могут быть плавающими (float) или
закрепленными (dock), с фиксированным местоположени-
ем. Допускаются изменения размеров плавающих панелей,
а также их перемещение по графическому полю (рис. 2.3).
Плавающую панель можно сделать закрепленной, перетащив
ее с помощью мыши за пределы графического поля. И на-
оборот, как только закрепленная панель попадает в область
графического поля, она превращается в плавающую.

Рис. 2.3. Плавающая панель инструментов



 
 
 

При необходимости требуемую панель инструментов
можно вывести на рабочий стол, щелкнув левой кнопкой
мыши на ее имени в списке контекстного меню. Для откры-
тия этого контекстного меню необходимо щелкнуть правой
кнопкой мыши, установив ее указатель на любую пиктограм-
му панелей инструментов (рис. 2.4).



 
 
 



 
 
 

Рис. 2.4. Список панелей инструментов

Для удаления панели инструментов необходимо сделать
ее плавающей, если она закреплена, и щелкнуть на кнопке
закрытия, расположенной в правом верхнем углу заголовка
панели.

Если набор необходимых панелей и окон упорядочен на
рабочем столе, во избежание их случайного перемещения
или удаления пользователь может зафиксировать их положе-
ние. Для этого следует вызвать контекстное меню щелчком
правой кнопки мыши на инструменте, изображающем замо-
чек, в правой части строки состояния и зафиксировать по-
ложение панелей:

• Floating Toolbars – плавающие панели инструментов;
• Docked Toolbars – закрепленные панели инструментов;
• Floating Windows – плавающие окна;
• Docked Windows – закрепленные окна;
•  Аll – все инструменты: Locked – заблокированы,

Unlocked – разблокированы;
• Help – справка.
Чтобы временно разблокировать панели инструментов,

необходимо удерживать нажатой клавишу Ctrl.
Совет
Выполните упражнение N3 из раздела 1.



 
 
 



 
 
 

 
Стандартная панель инструментов

 
Стандартная панель Standard показана на рис. 2.5.

Рис. 2.5. Стандартная панель инструментов

Она содержит следующие инструменты:

Qnew – создание нового файла рисунка;

Open… CTRL+0 – загрузка существующего файла;

Save CTRL+S – сохранение текущего файла;



 
 
 

Plot… CTRL+P – вывод рисунка на плоттер, принтер или
в файл;

Plot Preview – предварительный просмотр чертежа перед
выводом на печать, позволяющий увидеть размещение чер-
тежа на листе бумаги;

Publish… – публикация листов чертежа в формате фай-
ла Design Web Format (DWF), загрузка диалогового окна
Publish;

3DDWF – экспорт трехмерной модели в формате файла



 
 
 

Design Web Format (DWF);

Cut CTRL+X – копирование объектов в буфер обмена с
удалением их из рисунка;

Copy CTRL+C – копирование выбранных элементов чер-
тежа в буфер Windows без удаления их из исходного доку-
мента;

Paste CTRL+V – вставка данных из буфера Windows;

Match Properties – копирование свойств заданного объек-
та другому объекту;



 
 
 

Block Editor – редактирование блоков;

Undo – отмена последнего действия;

Redo – восстановление только что отмененного действия;

Pan Realtime – перемещение изображения на текущем ви-
довом экране в режиме реального времени;



 
 
 

Zoom Realtime – увеличение или уменьшение видимого
размера объектов на текущем видовом экране в режиме ре-
ального времени;

Подменю Zoom – раскрывающийся набор инструментов,
в котором можно задать различные способы увеличения и
уменьшения видимого размера объектов на текущем видо-
вом экране;

Zoom Previous – возврат к показу предыдущего вида;

Properties CTRL+1 – загрузка палитры управления свой-
ствами объектов;



 
 
 

DesignCenter CTRL+2 – диалоговый интерфейс, позволя-
ющий быстро находить, просматривать, вызывать, перено-
сить в текущий рисунок ранее созданные рисунки, управлять
вхождениями блоков, внешними ссылками и другими эле-
ментами рисунков, такими как слои, листы и текстовые сти-
ли;

Tool Palettes Window CTRL+3 – инструментальные палит-
ры в виде отдельных вкладок специального окна, которые
служат эффективным средством хранения/вставки блоков и
штриховки. Палитры могут содержать инструменты, предо-
ставленные сторонними разработчиками;

Sheet Set Manager CTRL+4 – диспетчер подшивок набо-
ров листов, позволяющий организовать размещение пакетов
листов в зависимости от типа чертежей и с возможностью
эффективного создания, управления и совместного исполь-
зования наборов логически связанных рисунков;



 
 
 

Markup Set Manager CTRL+7 – диспетчер наборов поме-
ток, позволяющий организовать работу с рисунками форма-
та DWF;

QuickCalc CTRL+8 – калькулятор;

Help – вызов справочной системы.



 
 
 

 
Панель стилей

 
Панель стилей Styles, показанная на рис. 2.6, предназна-

чена для создания новых текстовых, размерных и табличных
стилей.

Рис. 2.6. Панель стилей

Панель содержит следующие инструменты:

Text Style…  – создание новых и редактирование имею-
щихся текстовых стилей;

Dimension Style…  – создание новых и редактирование
имеющихся размерных стилей;



 
 
 

Table Style… – создание новых и редактирование имею-
щихся табличных стилей;

Multileader Style…  – создание новых и редактирование
имеющихся стилей линий-выносок.



 
 
 

 
Панель рабочих пространств

 
Панель Workspaces, показанная на рис. 2.7, размещается

на рабочем столе под стандартной па нелью инструментов и
позволяет задавать параметры рабочих пространств.

Рис. 2.7. Панель рабочих пространств

Рабочие пространства включают только необходимые на-
боры меню, инструментальные панели и палитры, сгруппи-
рованные и упорядоченные соответственно решаемой за-
даче. Элементы интерфейса, не являющиеся необходимы-
ми для решения текущей задачи, скрываются, максимально
освобождая область экрана, доступную для работы.



 
 
 

В AutoCAD определены следующие рабочие простран-
ства:

• 2D Drafting & Annotation – двумерное моделирование;
• 3D Modeling – трехмерное моделирование;
• AutoCAD Classic – классический AutoCAD.
Помимо возможности установить рабочее пространство в

панель Workspaces включены следующие пункты, осуществ-
ляющие:

•  Save Current As…  – открытие диалогового окна Save
Workspace, позволяющего сохранить текущее рабочее про-
странство;

•  Workspace settings…  – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-
метры рабочего пространства для последующего использо-
вания;

•  Customize…  – открытие диалогового окна Customize
User Interface, позволяющего осуществить настройки интер-
фейса пользователя.

Кроме того, панель Workspaces содержит следующие ин-
струменты:

Workspace Settings…  – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-



 
 
 

метры рабочего пространства для последующего использо-
вания;

My Workspace – возвращение имени текущего рабочего
пространства в интерфейс командной строки и установление
этого пространства текущим.

Рабочее пространство 3D Modeling включает новый пульт
управления, обеспечивающий удобный доступ к новым
функциям трехмерного моделирования, в области рисова-
ния отображается цвет фона, наземная плоскость или рабо-
чая поверхность и новая прямоугольная сетка, что улучшает
трехмерную визуализацию и облегчает создание простран-
ственных моделей. Новый трехмерный курсор обеспечива-
ет указание направления ПСК. Вкладки Model и Lauout за-
менены кнопками в строке состояния, благодаря чему рас-
ширена область рисования. На режим отображения вкладок
можно переключиться, нажав правую кнопку мыши на кноп-
ке Model или Lauout.



 
 
 

 
Панель слоев

 
Панель слоев Layers, показанная на рис. 2.8, размещается

на рабочем столе под стандартной панелью инструментов и
обеспечивает работу со слоями.

Рис. 2.8. Панель слоев

В нее входят следующие инструменты:

Layer Properties Manager – вызов Диспетчера свойств сло-
ев Layer Properties Manager;

Filter applied – раскрывающийся список управления сло-
ями.



 
 
 

Каждая строка содержит пиктограммы управления свой-
ствами слоя или отображения его свойств, а также его имя.
Ниже перечисляются эти пиктограммы (слева направо):

• Turn a layer On or Off – включение/отключение слоя;
• Freeze or thaw in ALL viewports – замораживание/размо-

раживание на всех видовых экранах;
• Freeze or thaw in current viewport – замораживание/раз-

мораживание на текущем видовом экране;
• Lock or Unlock a layer – блокирование/разблокирование

слоя;
• Color of layer – цвет слоя;
• Filter applied – имя слоя;

Make Object's Layer Current – установка текущего слоя в
соответствии со слоем выбранного примитива;

Layer Previous – возврат к предыдущему состоянию слоев;



 
 
 

Layer States Manager – загрузка диалогового окна Layer
States Manager.



 
 
 

 
Панель свойств объектов

 
Панель свойств объектов Properties, показанная на

рис. 2.9, размещается на рабочем столе под стандартной па-
нелью инструментов и предназначена для работы с цветом,
типом и весом линий.

Рис. 2.9. Панель свойств объектов

В нее входят следующие инструменты:

Color Control – раскрывающийся список установки теку-
щего цвета, а также изменения цвета выбранных объектов;

Linetype Control – раскрывающийся список установки те-
кущего типа линии, а также изменения типа линии для вы-



 
 
 

бранных объектов;

Lineweight Control – раскрывающийся список установки
текущего веса (толщины) линии, а также изменения толщи-
ны линий выбранных объектов;

Plot Styles Control – раскрывающийся список установки
стилей печати. Здесь можно изменять внешний вид вычер-
чиваемого на плоттере рисунка. В стилях печати при необ-
ходимости переопределяются цвета, типы и веса (толщины)
линий объектов. Кроме этого, имеется возможность указы-
вать используемые при печати стили концов линий, соеди-
нений и заполнений, а также различные выходные эффекты
– размывание, оттенки серого, присвоения перьев и интен-
сивность. Манипулируя стилями печати, можно получить на
бумаге различные варианты одного и того же рисунка. До-
пускается применение стилей печати к объектам или слоям.



 
 
 

 
Строка состояния

 
Строка состояния (рис. 2.10) расположена в нижней части

рабочего стола.

Рис. 2.10. Строка состояния

Она содержит текущие координаты курсора, а также кноп-
ки включения/выключения режимов черчения:

• SNAP – Snap Mode, включение и выключение шаговой
привязки курсора;

• GRID – Grid Display, включение и выключение отобра-
жения сетки;

• ORTHO – Ortho Mode, включение и выключение орто-
гонального режима;

• POLAR – Polar Tracking, включение и выключение ре-
жима полярного отслеживания;

• OSNAP – Object Snap, включение и выключение режи-
мов объектной привязки;

• OTRACK – Object Snap Tracking, включение и выклю-
чение режима отслеживания при объектной привязке;

• DUCS – Allow/Disallow Dynamic UCS, включение и вы-
ключение динамической пользовательской системы коорди-



 
 
 

нат;
• DYN – Dynamic Input, включение и выключение дина-

мического ввода;
• LWT – Show/Hide Lineweight, включение и выключение

режима отображения линий в соответствии с весами (тол-
щинами);

• MODEL/PAPER – Model or Paper space, переключение
из пространства модели в пространство листа.

Отображение кнопок включения/выключения режимов
черчения в строке состояния устанавливается в контекстном
меню (рис. 2.11). Для этого необходимо щелкнуть левой или
правой кнопкой на инструменте Status Bar menu с изображе-
нием стрелки вниз, который находится в правой части стро-
ки состояния.



 
 
 

Рис. 2.11. Контекстное меню настройки строки состояния

Команда Tray Settings… открывает диалоговое окно Tray
Settings (рис. 2.12), позволяющее произвести настройку об-
ласти уведомлений, а именно:



 
 
 

• Display icons from services – показывать значки служб;
• Display notifications from services – показывать уведом-

ления от служб:
– Display time: – время отображения;
– Display until closed – до явного закрытия.

Рис. 2.12. Диалоговое окно настройки области уведомле-
ний



 
 
 

 
Окно командных строк

 
Окно командных строк обычно расположено над строкой

состояния; оно служит для ввода команд и вывода подсказок
и сообщений AutoCAD. Размеры окна, а следовательно, ко-
личество выводимых строк протокола можно изменять. При
наличии в окне команд более одной строки перемещение по
строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по шири-
не окну AutoCAD (рис. 2.13). Если текстовая строка не по-
мещается в окне, ее полное содержимое выводится в рамке
вблизи командной строки.

Рис. 2.13. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной
полосы, находящейся в его верхней части (если оно закреп-
лено внизу) или в нижней (если оно закреплено вверху). Что-
бы изменить размер, следует захватить разделительную по-
лосу с помощью мыши и «отбуксировать» ее до требуемой
высоты.

Окно может быть как закрепленным, так и плавающим.
Закрепление отменяется путем выбора рамки окна в любом



 
 
 

месте и последующей буксировки за пределы зоны закреп-
ления до тех пор, пока граница окна не примет вид широ-
кой контурной линии. Если отпустить окно в этот момент,
оно станет плавающим и приобретет размер, который имело
до закрепления. Плавающее окно может быть перемещено в
любую позицию экрана; при этом пользователю разрешено
изменять его ширину и высоту (рис. 2.14).

Рис. 2.14. Плавающее окно командных строк

Закрепляется окно команд путем «буксировки» к верхней
или нижней зоне закрепления окна AutoCAD.

В окне командных строк можно прокручивать текст, вы-
полнять его редактирование и повторно вводить команды.
Для этого используются стандартные клавиши: ↑, ↓, ←, →,
Insert, Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно восполь-



 
 
 

зоваться комбинацией клавиш Ctrl+C, чтобы копировать вы-
деленный текст в буфер обмена, и Ctrl+V, чтобы вставить
содержимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных
строк или текстового окна AutoCAD вызывает контекстное
меню, куда входят шесть последних использованных команд,
функции копирования выделенного текста или всего прото-
кола команд, вставки текста, а также вызова диалогового ок-
на настройки Options.



 
 
 

 
Текстовое окно

 
Чтобы просмотреть большую часть протокола команд –

так называемую историю команд (command history), можно
переключиться в текстовое окно, показанное на рис.  2.15.
Это окно вызывается нажатием функциональной клавиши
F2 или командой TEXTSCR, а также с помощью меню View
→ Display → Text Window F2.

Рис. 2.15. Текстовое окно



 
 
 

Текстовое окно подобно окну команд: в нем также можно
вводить команды, наблюдать подсказки и сообщения, выда-
ваемые AutoCAD. Для перемещения по окну используется
полоса прокрутки или клавиши ↑, ↓, ←, →, Page Up и пр.

Содержимое текстового окна предназначено только для
чтения и не подлежит изменению. Но протокол команд мож-
но копировать для последующей вставки в командную стро-
ку или текстовый редактор.



 
 
 

 
Контекстное меню

 
Для выбора пунктов меню и пиктограмм на панели ин-

струментов часто используется устройство указания – мышь.
При работе с мышью нажатие левой кнопки в области рисо-
вания обычно используется для выбора и указания точки на
экране; щелчок правой кнопкой мыши вызывает контекст-
ное меню, которое обеспечивает быстрый доступ к командам
(см. рис. 2.4, 2.16). Форма и содержание меню зависят от по-
ложения указателя мыши и состояния задачи.



 
 
 

Рис. 2.16. Пример контекстного меню



 
 
 

 
Инструментальные палитры

 

Инструментальные палитры загружаются командой
TOOLPALETTES, либо из падающего меню Tools → Palettes
→ Tool Palettes CTRL+3, либо щелчком на пиктограмме Tool
Palettes Window CTRL+3 на стандартной панели инструмен-
тов.

Инструментальные палитры представляют собой отдель-
ные вкладки, объединенные в специальном окне TOOL
PALETTES (рис. 2.17), и являются эффективным средством
хранения и вставки блоков и штриховки, а также могут со-
держать инструменты, предоставленные сторонними разра-
ботчиками.



 
 
 



 
 
 

Рис. 2.17. Инструментальная палитра

В разных областях окна инструментальных палитр с по-
мощью контекстных меню можно изменять следующие на-
стройки:

• автоматически убирать палитры с экрана – окно инстру-
ментальных палитр может автоматически разворачиваться и
сворачиваться при подведении указателя мыши к строке за-
головка окна и отведении от нее;

•  прозрачность – окно палитры инструментов делается
прозрачным и не скрывает находящиеся за ним объекты (эта
функция недоступна для пользователей Microsoft Windows
NT);

• вид – изменяются стиль и размер отображаемых в па-
литре значков.

Окно инструментальных палитр при необходимости мож-
но закрепить у правой или левой границы окна программы.
Для того чтобы избежать закрепления, при перемещении ок-
на следует удерживать нажатой клавишу Ctrl.

На палитрах удобно размещать часто используемые блоки
и штриховки. Для того чтобы вставить блок или штриховку
из палитры в рисунок, необходимо «захватить» элемент па-
литры с помощью мыши и перетащить его в графическую
область.

Блоки и штриховки, размещенные на палитре, носят на-
звание «инструментов». Некоторые свойства инструментов,



 
 
 

включая масштаб, угол поворота и слой, могут устанавли-
ваться отдельно для каждого инструмента.

При перетаскивании блока с инструментальной палитры
на рисунок он автоматически масштабируется в зависимости
от соотношения заданных единиц блока и единиц текущего
рисунка. Например, если в качестве единиц измерения дан-
ного рисунка используются метры, а в качестве единиц из-
мерения блока – сантиметры, то коэффициент пересчета со-
ставляет 1: 100. Соответственно, при перетаскивании блока
в рисунок его размеры меняются в пропорции 1: 100.



 
 
 

 
Пульт управления

 
В рабочее пространство 3D Modeling включен новый

пульт управления DASHBOARD, который по умолчанию за-
креплен с правой стороны области рисования. Он содержит
кнопки и элементы управления, ориентированные на задачи
установленного рабочего пространства (рис. 2.18).



 
 
 



 
 
 

Рис. 2.18. Пульт управления

Пульт управления представляет собой набор управляю-
щих панелей, на которых расположены соответствующие ин-
струменты и элементы управления, аналогичные инструмен-
там панелей и элементам управления диалоговых окон.

Слева на пульте отображены значки, обозначающие на-
значение управляющей панели. При нажатии на значок от-
крывается текущая всплывающая панель, содержащая до-
полнительные инструменты. Более одной всплывающей па-
нели отобразить невозможно, поэтому при нажатии на дру-
гой значок, открытая панель автоматически закрывается.



 
 
 

 
Центр управления

AutoCAD DesignCenter
 

В практической деятельности очень важно иметь возмож-
ность использовать созданные ранее наработки: опыт пока-
зывает, что большинство проектно-конструкторских проек-
тов создается на базе новых сочетаний элементов, давно из-
вестных как по принципу функционирования, так и по ис-
полнению. AutoCAD обеспечивает эффективное повторное
использование имеющихся наработок путем их вставки в ри-
сунки в виде блоков или внешних ссылок. Управлять бло-
ками, внешними ссылками, растровыми изображениями и
содержимым рисунков, находящихся в других источниках
(и даже подготовленных в других приложениях), позволяет
Центр управления AutoCAD DesignCenter.

Кроме того, если в сеансе открыто несколько рисунков,
Центр управления дает возможность упростить процесс со-
здания таких элементов, как, например, описания одних и
тех же слоев. Пользователь создает описание в одном рисун-
ке, а затем просто копирует в остальные.

Центр управления DesignCenter предназначен для орга-
низации доступа к чертежам и их элементам и обеспечивает:

•  просмотр содержимого чертежей на локальном диске,
сетевом диске и веб-страницах;

• просмотр и вставку в текущий чертеж блоков, слоев, тек-



 
 
 

стовых и размерных стилей, типов линий, внешних ссылок,
образцов штриховки и прочих элементов чертежей;

• доступ к растровым изображениям и сторонним объек-
там, созданным в других приложениях;

• обновление описания блоков;
•  перетаскивание элементов чертежа на инструменталь-

ные палитры.

Центр управления AutoCAD загружается командой
ADCENTER, либо из падающего меню Tools → Palettes
→ DesignCenter CTRL+2, либо щелчком на пиктограмме
DesignCenter CTRL+2 на стандартной панели инструментов
(рис. 2.19).



 
 
 

Рис. 2.19. Центр управления DesignCenter

Центр управления имеет интуитивно понятный интер-
фейс и позволяет быстро находить, просматривать, вызывать
и применять специфические компоненты, такие как блоки,
слои, типы линий и пр. Причем эти операции осуществля-
ются из открытых или закрытых файлов AutoCAD, незави-
симо от того, где они находятся: на локальных или удален-
ных дисках. Достаточно просто выбрать нужные компонен-
ты и перетащить их в текущий рисунок.



 
 
 

 
Конец ознакомительного

фрагмента.
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